Using Microsoft® Works© to 


Build Word Lists and to Track Results


for Quiz-n-Spell





[Most of the techniques described on this page also apply to other databases and spreadsheets.  The techniques used in the examples below are simple step-by-step instructions to accomplish some very sophisticated and powerful computing operations involving copying and pasting between two open documents.


Beginning computer users will need to be familiar with opening Microsoft Works and starting new documents.  They will also need to know how to use both the mouse and the keyboard.]





There are two tutorial topics on this page, plus some tips:


Build a word list using Microsoft Works.  This requires beginning to medium computer skills, and should take less than thirty minutes the first time.  After you have learned how it is done, building a word list using this method should take only a few minutes.


Build a report to track results using Microsoft Works.  This requires beginning to medium computer skills, and should take less than fifteen minutes.  After you have learned how it is done, building a report using this method should take only a couple of minutes.


Getting Started and More Tips - here are some hints and how-to tips for getting things done, with sections for databases, spreadsheets, word processor documents, the system clipboard and links to other information.








Build a word list using Microsoft Works


[There is a Microsoft Works 6 database template included on the SpellerBee CD.  It is “<CD>:\21Firs Website Files\support\updates\SB_WordList.wdb”, where <CD> is the drive letter for the CD.  Double-click on that file – the one named "SB_WordList.wdb". Immediately after the new database opens, go to the Works "File" menu item and click it, then click on "Save As...", then click the <Template...> button in the file dialog box that opens. Do not set the default check. Type in the name "SB_WordList.wdb" (without the quotes), and click <OK>. Now you can use this template as the basis for any new word list.  You can find the new template by starting the Works Task Launcher, and looking in “Personal Templates”.  Proceed with this tutorial.]





(To build a word list using Microsoft Excel, or other spreadsheet program, see the Spreadsheet Tips section below.)





By setting up a simple database using Microsoft Works Database, you can easily create word lists that can be used in SpellerBee.  This has been tested with Microsoft Works 6.0.


Start a new database (open the Microsoft Works Task Launcher, and click on 'Works Database') 


Click on 'Start a blank database' 


(The next steps show you how to define the fields in the database.  There will be four fields, 'Word', 'Definition', 'Hint', and 'Sentence', all of which you will check as type 'Text'.)


In the "Create Database" dialog box that opens on top of the new database, type in "Word" (without the quotes), and click on the "Text" item in the "Format" section.  Then click the <Add> button.  The field will be added to the database. 


Now, in the "Create Database" dialog box, type in "Definition" (without the quotes), and click on the "Text" item in the "Format" section.  Then click the <Add> button.  Repeat for "Hint" and "Sentence". 


Lastly, in the "Create Database" dialog box, click <Done>.  (See Figure 1, below) 


Save the database with an appropriate name, such as "SB_WordList".  Microsoft Works will automatically open your "My Documents" folder, and you will be able to find the database there in the future (unless you select a different location, of course). 





Now you can enter a word list.  Type each word into the "Word" field, the definition into the "Definition" field, and the hint and sentence into the appropriate fields.  There must be a word, but the definition, hint and sentence are each optional.  You may choose to enter only words and sentences, or words and definitions, or words and hints and sentences. 





REMEMBER to replace the "Word" with three question marks when you enter a Sentence (for example, see Figure 1 below).





Do not leave any blank records between word rows (records).  If there are blank rows, delete them.  Words (and their definitions, hints, and/or sentences) should be entered in consecutive rows (records).





After you have entered the list, keep the database open, and open the Microsoft Works Word Processor. (You can use Microsoft Windows Notepad or Microsoft Windows Wordpad, though if you use Wordpad, be sure to save the file you are about to build as a 'text' file.)  Click on 'Start a blank word processor document'.





Next, switch back to the database and select and copy all the word records that you just entered.  To do this:


Point to the first word (the 'Word' field of the first record) that you entered, then click and hold down the left mouse button.


Drag the mouse down to the sentence (the 'Sentence' field) of the last word you entered.  Select the 'Sentence' field even if it is empty.





Your database worksheet should look something like this:
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In the database, you can make the columns wider or narrower by pointing at the line between the heading fields (for example, the line between 'word' and 'definition', or between 'hint' and 'sentence') and dragging the line to the right or left.  'Dragging' means to click and hold the mouse button down and move the mouse.


Now, move the mouse pointer up to the Database menu bar and click on "Edit".  Move the pointer down and click on "Copy".  (You have just copied the information from the database records onto something called the 'system clipboard')


Switch back to the Word Processor document you opened.


Move the mouse pointer to the menu bar and click on "Edit".  Move the pointer down and click on "Paste Special...", and select "Unformatted text".  (You have just pasted the information from the clipboard into your document.)


IMPORTANT:  Be sure that you do the two operations consecutively - copy and paste - without opening another program or doing some other copy operation in between, otherwise the results may not be what you expected.


Now save the document like this:


Move the mouse pointer to the menu bar and click on "File", and move the mouse pointer down and click on "Save As..." 


In the "Save File" dialog box that opens, you will see a dropdown combobox labeled "Save as type:".  Move the mouse pointer down and click the dropdown arrow and then click on "Text File (*.txt; *.csv)". 


Now move the mouse pointer back up to the edit box just above (the one labeled "File name:"), and type in a name for the file (maybe 'SB_WordList'). 


Click the <Save> button. 


When you copied the information from the database to the document, Microsoft Works automatically added a 'tab' delimiter between the fields.





That is one way to build a word list using Microsoft Works.





To import the list into SpellerBee, do the following steps:


Open SpellerBee 


Click the large 'A' 


Type in the name for a new list (maybe "test", without the quotes) 


Click the <Add> button 


Click the <Utils...> button 


You will not have to change the delimiter, since Microsoft Works automatically added 'tab' delimiters. 


In the "Word List Utilities" dialog box, click on the <Import...> button 


A "Browse for Folder" box will open 


Select the text file that you saved (above) [be sure to click on the file to highlight it] 


Click the <OK> button 


(You will be given a chance to change the prompt for the list.  At this point, ignore that and click <No>. 





You have finished importing a text delimited file into SpellerBee.





You can record word pronunciations by using the SpellerBee Word List Editor.  See the SpellerBee help files for complete information about word list management.





Build a report to track results using Microsoft Works





Using Microsoft Works Spreadsheet, you can easily create reports from SpellerBee test results.  This has been tested with Microsoft Works 6.0.





This portion of the tutorial requires that one or more test results have been stored from student tests.





First, you need to export the test results from SpellerBee.


Open SpellerBee 


Click on the large 'A' 


Click on the <Results...> button 





(The "SpellerBee Open Results File" dialog box will open, and you can select one or more files to view.  To select more than one file, hold down the keyboard <Ctrl> key and then point and click on each file you want using the the mouse.  NOTE:  files with an ".sbx" extension are results from word tests, while files with an ".sbv" extension are results from sentence tests.)





Click the <Open> button.  (The "SpellerBee Open Results File" dialog box will close, and the "Misspelled WordList Admin Dialog" box will be displayed.)





The results will be displayed in the list box.


Click the <Export...> button. 


The name for the file to be exported will be suggested or you can change the name.  Either way, remember what the name of the file is.  It will automatically be given a ".txt" extension. 


Click the <Save> button.





(Microsoft Windows will automatically save the file in your "My Documents" folder, unless you change the location.) 





Now open Microsoft Works Spreadsheet.  (Open the Microsoft Works Launcher, and click on 'Works Spreadsheet')





Keep the new spreadsheet open.





Open the "My Documents" folder.  Usually, you can click on the Microsoft Windows "Start" button (down in the lower left corner of the screen) and find "My Documents" (on Windows 98, click the 'Documents' item, then click 'My Documents').


(You should be able to see the text file that you saved (above).) 


Double click on it.  It should open in Microsoft Windows Notepad. 


Click on the menu item 'Edit'. 


From the menu that drops down, click on 'Select All'.  (All the text in the editing area should be highlighted.) 


Click on the 'Edit' menu item again, then click on 'Copy'. 





Switch to the new spreadsheet that you started (above).


Where the text is inserted will depend on which cell you select.  For this exercise, click the first cell (A1). 


Click on the menu item 'Edit'. 


From the menu that opens, click 'Paste'. 





You should see the test results pasted into the spreadsheet.


Information is added to the spreadsheet so that you can easily see which words are being misspelled.


You might want to add a status line to the top of the spreadsheet, where you can put the date and other pertinent information.  Simply click on the top row and then click the 'Insert' menu item, and click 'Insert Row'.


You can save the spreadsheet for future reference by clicking the 'File' menu item, then clicking 'Save'.  Give the file an appropriate name.


Using this technique, you can add more reports to this spreadsheet to track progress over a term.  You can copy and paste between different spreadsheets.  You can print the spreadsheet.





Getting Started and More Tips





Working with Databases:


It can be helpful to set the view to "Form" (click the 'View' menu item, then click 'Form') when entering a number of items.





 


Working with Spreadsheets:


If you want to use Microsoft Excel (or another, full-featured spreadsheet program) for building word lists, then read this.  When working with word lists for SpellerBee, if for example you have only the words and definitions but no hints or sentences, then you might need to 'fill' the hint and sentence columns to set the delimiter.  


You can always set the delimiter manually, but this example shows a faster, easier, safer method to automatically set it to a 'tab' character.  


In this example, assume you have a list of words and their definitions, but the hint and sentence columns are empty.


To set up the list so that you can import it into SpellerBee, click on the hint column head to select the whole column, then click 'Edit' and then 'Fill' and select 'Down'.  


Repeat for the sentence column.  


The fill operation automatically stores a 'tab' character in each cell of the column. 


Select the words, definitions and two blank columns for all the words (make sure the area is four columns wide) and copy it.  This "select and copy" operation is done the same way as outlined above. 


The information will be copied onto the clipboard. 


Finally, open Notepad (or you can use any word processor; just be sure to save the file as a text [".txt"] file) and paste the information in, then save the file. 


Open SpellerBee, either start a new list and add it, or select an existing list to merge the new list into, then click the <Utils...> button. 


Import the new list. 


Be sure to read all the relevant information in the SpellerBee help files for complete word list management.





Working with Documents:


A document can be stored in many styles and ways.  Several of the most common document types are word processor documents, web page documents and simple text documents.  


A word processor document stores information about how the document is formatted, such as font styles and sizes, margins, header and footer information, and more, in addition to the actual information in the document.  There are many different word processors, and each one stores documents in its own way.  Often, word processors will have converters built into them so that one word processor can read and/or write different document types. 


A web page document is a special kind of document, based on HTML which stands for 'hyper-text markup language', that stores its formatting information in a common style so that different types of web browsers (sometimes called HTML document viewers) can display the document in the same way. 


A simple text document stores only the information plus the most basic formatting information – just tab characters and line-end characters, et al. 








For more information, see http://www.21firs.com/spellerbee/compskills.htm for some keyboard shortcut tips, editing techniques, file operations, the system clipboard and more.


